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Introduction

What you’ll find in this manual...

Instrument details...

Unpacking and inspection

Certification

Warranty

Contact information

• The Rugged TROLL Instrument measures level and temperature.

• Use it in natural groundwater, surface water, industrial waters, and other installations.

• Setup, calibration, and deployment instructions

• Maintenance information

• Modbus and SDI-12 programming overview

• Your instrument was carefully inspected before shipping. 

• Check for any physical damage sustained during shipment. 

• Notify In-Situ and file a claim with the carriers involved if there is any shipping damage. 

• Accessories may be shipped separately. Inspect them for physical damage and verify that all of the  

 items you ordered are present.

• The serial number is engraved on the instrument housing. 

• It is also programmed into the instrument and is displayed when the instrument is connected to the  

 VuSitu mobile app or a computer running Win-Situ Software.

• See the Declarations of conformity at end of this manual.

See the product specification tables for warranty information.

Mailing and shipping 

address:

In-Situ
221 East Lincoln Avenue 
Fort Collins, CO 80524-2533 U.S.A.

Phone: 970-498-1500 (international & domestic)

Fax: 970-498-1598

Internet: www.in-situ.com

Support: 800-446-7488 (U.S.A. & Canada)

Serial number location

51-970-498-1500 www.in-situ.com



Product specifications

Rugged TROLL 100 and 200 specifications

Temperature ranges1
Operational: 0 to 50° C (32-122° F) 
Storage: -40 to 80° C (-40 to 176° F) 
Calibrated: 0 to 50° C (32 to 122° F)

Diameter 2.62 cm (1.03 in.)

Length 14.43 cm (5.68 in.)

Weight 137 g (0.30 lb)

Materials Titanium, Acetal, FKM Fluoroelastomer, Ceramic

Output options

Rugged TROLL 100: USB or RS232 via docking 
station
Rugged TROLL 200: USB or RS232 via docking 
station; Modbus/RS485 or SDI-12 via Rugged TROLL 
200 Cable; Wireless TROLL Com

Battery type & life2 3.6 V lithium; 10 years or 2M readings

External power
Rugged TROLL 100: NA 
Rugged TROLL 200: 8-36 VDC

Memory
Data records3
Data logs

2.0 MB
120,000
Rugged TROLL 100: 1 log; Rugged TROLL 200: 2 logs

Fastest logging rate 1 per second

Fastest output rate
Rugged TROLL 200 only: Modbus & SDI-12: 1 per 
second

Log types Linear, Fast Linear, and Event

Sensor Type/Material Piezoresistive; Ceramic

Range
9.0 m (30 ft) (Burst: 18 m; 60 ft) 
30 m (100 ft) (Burst: 40 m; 134 ft) 
76 m (250 ft) (Burst: 112 m; 368 ft)

Accuracy (FS)4 ±0.1%

Resolution ±0.01% FS or better

Units of measure
Pressure: psi, kPa, bar, mbar, mmHg, inHg Level: in, 
ft, mm, cm, m

Temperature Sensor

Accuracy ±0.3° C
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Resolution 0.01° C or better

Units of measure Celsius or Fahrenheit

Warranty 2 years

Footnotes

1 Temperature range for non-freezing liquids
2 Typical battery life when used within the factory-
calibrated temperature range 
3 1 data record = date/time plus 2 parameters 
logged (no wrapping) from device within the 
factory-calibrated temperature range, 360,000 total 
data points
4 Across factory-calibrated pressure and 
temperature ranges. Defined as greater than 98% of 
all readings fall within spec across temperature and 
pressure range Specifications are subject to change 
without notice.
Delrin is a registered trademark of E.I. du Pont de 
Nemours and Company.

Rugged Baro TROLL specifications

General Rugged Baro TROLL

Temperature ranges1
Operational: 0-50° C (32-122° F) 
Storage: -40-80° C (-40-176° F) 
Calibrated: 0-50° C (32-122° F)

Diameter 2.62 cm (1.03 in.)

Length 14.43 cm (5.68 in.)

Weight 137 g (0.30 lb)

Materials Titanium body; Delrin nose cone, hanger, backend

Output options
USB or RS232 via docking station; Modbus/RS485 or 
SDI-12 via Rugged TROLL 200 Cable

Battery type & life2 3.6 V lithium; 10 years or 2M readings

External power 8-36 VDC

Memory
Data records3
Data logs

2.0 MB
120,000
2 logs

Fastest logging rate 1 per minute

Fastest output rate Modbus & SDI-12: 1 per second

Log types Linear

Sensor Type/Material Piezoresistive; Ceramic
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Range 7.0 to 30.0 psi; 0.5 to 2 bar

Accuracy (FS)4 ±0.1%

Resolution ±0.01% FS or better

Units of measure Pressure: psi, kPa, bar, mbar, mmHg, inHg

Temperature Sensor

Accuracy ±0.3° C

Resolution 0.01° C or better

Units of measure Celsius or Fahrenheit

Warranty 2 years

Footnotes

1 Temperature range for non-freezing liquids
2 Typical battery life when used within the factory-
calibrated temperature range. 
3 1 data record = date/time plus 2 parameters 
logged (no wrapping) from device within the 
factory-calibrated temperature range
4 Across factory-calibrated pressure range and 
temperature ranges. Defined as greater than 98% of 
all readings fall within spec across temperature and 
pressure range
Specifications are subject to change without notice.
Delrin is a registered trademark of E.I. du Pont de 
Nemours and Company.
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Overview

Rugged TROLL overview

Rugged Baro TROLL overview

Communication accessories

Rugged TROLL 100

Other accessories

• The Rugged TROLL 100 and 200 instruments measure pressure, level, and temperature in natural 

groundwater and surface water. They also can be used at industrial sites, landfills, and other 

installations.

• Both instruments have completely sealed housings that contain an absolute (non-vented) pressure 

sensor, temperature sensor, real-time clock, microprocessor, lithium battery, and internal memory.

• The Rugged TROLL 100 is designed to hang by a backshell hanger from a suspension wire. The 

Rugged TROLL 200 can utilize the backshell hanger or can connect to a cable for easy top-of-

well RS485 communications via laptop computer or mobile device. Additionally, Rugged TROLL 

200 cables with stripped-and-tinned cable ends can communicate with data loggers, TROLL Link 

Telemetry Systems, or PLC devices via RS485 or SDI-12.

Rugged TROLL 100:

• USB or RS232 docking station

• Wireless Rugged TROLL COM

Rugged TROLL 100,200 and Rugged BaroTROLL Instruments:

• USB or RS232 docking station

• USB or RS232 Rugged TROLL Com

• Wireless RuggedTROLL Com

Software

• Win-Situ 5 Software or VuSitu mobile app for programming and downloading

• Optional software: Win-Situ Baro Merge for barometric compensation

• The Rugged BaroTROLL measures and logs barometric pressure and temperature in air. This data 
is used to correct the Rugged TROLL 100 and 200 data by compensating for barometric pressure 
effects during the course of a log.

• Suspension cable

• Rugged BaroTROLL for logging barometric pressure data
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Rugged TROLL 200

• Suspension cable

• Rugged BaroTROLL for logging barometric pressure data

• SDI-12 compatible cable with stripped-and-tinned uphole termination

• RS485 compatible cable with stripped-and-tinned uphole termination

• RS485 top-of-well cable

• Rugged TROLL 200 cable suspension kit (Use this kit to create a weight-bearing loop capable of 
suspending up to 45.5 kg (100 lbs.) of cable and instrument.)

Data logger Deployment options Communication device

Rugged TROLL 100

Suspension wire
—one per Rugged TROLL
&
Rugged Baro TROLL
—one per network of Rugged TROLLs
—requires an additional suspension wire

Wireless Rugged TROLL Com

Rugged TROLL Docking Station*

Rugged TROLL 200

Option (A)

Suspension wire
—one per Rugged TROLL
&
Rugged Baro TROLL
—one per network of Rugged TROLLs
—requires an additional suspension wire

Wireless Rugged TROLL Com
Rugged TROLL Docking Station*

Option (B)

RS485 Direct-read cable
—one per Rugged TROLLs
&
Rugged Baro TROLL
—one per network of Rugged TROLLs
—requires additional RS485 cable for 
real-time data

Wireless Rugged TROLL Com
Rugged TROLL Com**
—one per cable for top-of-well data
—one per network—download only

Option (C)

SDI-12 Direct-read cable
&
Rugged Baro TROLL
—one per network of Rugged TROLLs
—requires additional SDI-12 cable for 
real-time data

Wireless Rugged TROLL Com
PLC/SCADA
&
Rugged TROLL Docking Station***

Equipment configuration table

* A Rugged TROLL Docking station can connect to one data logger at a time.
** In this deployment option, make sure to include an additional Rugged TROLL Com for real-time data from 
the Rugged BaroTROLL.
*** In this deployment option, a Rugged TROLL Docking Station is required for communication with the data 
loggers when not connected to the SDI-12 Direct-Read Cable.
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Getting started
You will need the following items.

• Rugged TROLL 100 or 200 instrument

• Rugged BaroTROLL (optional)

• One of the communication devices below

• USB or RS232 docking station and Rugged TROLL Com (for Rugged TROLL 200 and Rugged   
BaroTROLL).

• Wireless Rugged TROLL Com (if using the VuSitu mobile app)

Install software

VuSitu Mobile App

Win-Situ 5 software

Win-Situ Baro Merge software

You can configure and deploy your In-Situ instrument with the VuSitu mobile app or Win-Situ 5 software 
for PC. To use Win-Situ, install it from the In-Situ website. Download VuSitu on your mobile device from the 
Google Play Store at
play.google.com.

VuSitu is the mobile user interface and control application for In-Situ water quality instruments. You can use 
VuSitu on mobile devices with Android operating system 4.4, Bluetooth 2.0 and newer. Download the latest 
version of the app from the Google Play Store at play.google.com.

VuSitu allows you to accomplish the following tasks.

• View live readings that update every 10 seconds

• Change parameters and units

• Set up a data log

• Record data

• Email data in spreadsheet format

• Download data to mobile device

• Transfer data from mobile device to a computer

• Organize data by Location

• Calibrate Sensors and View Reports

Install Baro Merge Software if you plan to post-correct level data to compensate for barometric pressure.

1 Click the Win-Situ 5 link and follow the installation instructions.

2 Make sure that you select the option to “Install USB Drivers.”

To avoid potential compatibility issues, it is important to use the most recent version of the 
VuSitu Mobile App. Find version information and app updates from the Google Play Store.
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Connecting Your Instrument to VuSitu

The features available in the VuSitu mobile app vary slightly depending on the instrument to which it is 
connected. Tap the menu icon in the upper left portion of the screen to view the features included in VuSitu. 
Tap the menu icon again to close the menu.

Some features, such as sensor calibration, are not available when you are not connected to an instrument.

Vusitu Menu Options

Connecting to VuSitu

Menu Options when Connected to Instrument

You must have the VuSitu mobile app to use the instrument with a mobile device. Download 
VuSitu from the Google Play Store or the Apple App Store.

Attach an instrument 
and turn on the Wireless 
Rugged TROLL Com. 
Launch VuSitu. The 
app will automatically 
connect.

a
To connect to another 
instrument, press 
Disconnect.  VuSitu 
displays a list of available 
connections.

b
VuSitu displays the 
Connected Instrument 
screen when pairing is 
complete.

c

Level TROLL 500

121-970-498-1500 www.in-situ.com



Live Readings Screen

Snapshot Mode

Tap the button on the 
bottom left to toggle 
between snapshot and 
live readings modes.

Tap Save Single Reading 

to create a snapshot.
Tap Change Location 

in the top right corner 
if you wish to associate 
this data with a different 
location.

View the file from the 
Data Files screen.

Choose the desired 
location and press Save 

in the bottom right 
corner of the screen.

VuSitu confirms the new 
snapshot file.

Live Readings Mode

Tap the button on the 
bottom left to switch 
from snapshot mode to 
live readings mode.

Tap Start Recording. 
The instrument takes 
a reading every two 
seconds.

Tap Stop to end the 
recording. VuSitu displays 
a summary of the live 
readings data. 

Tap Save to if you wish to 
share the Live Readings 
file via email or cloud 
storage.

The live readings screen displays measurements taken from the instrument every two seconds. 
You can save these readings and share them via email or cloud storage.
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Changing Parameters and Units

Downloading and Sharing Your Data

You can transfer a data file from your mobile device to a PC via Bluetooth, email it to yourself or 
any valid email address, or upload it to Google Drive.

VuSitu displays a 
progress bar while 
downloading.

Choose the data you wish 
to download. To save the 
entire log to your phone, 
choose All data.

Pair VuSitu with the 
instrument. Select 
Logging from the 
Connected Instrument 
screen.

Tap a log and press the 
Download button.

From the Live Readings 
screen, tap the settings 
wheel next to the 
field that contains the 
measurement value.

Tap the parameter drop-
down arrow and tap the 
parameter you want to 
display.

Tap the units drop-down 
arrow and tap the unit 
you want to display.

Tap the OK button to set 
the options and return to 
the Live Readings screen.
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Sharing Data

Viewing Data on a Mac or PC

You’ll need to extract your files to view them. To do that on a Mac, double-click the Zip folder. 
On a PC, right-click on the folder and choose Extract. Then open your files in Excel.

Select Data Files from 
the menu at the top left 
corner of the screen.

Tap and hold the name 
of the log you want to 
share.

Select Export. Choose email, cloud 
storage, or another 
sharing option.

To save data locally on your mobile device, export to a third-party file management app.
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Connect to the Rugged TROLL Docking Station

Connect to the Wireless Rugged TROLL Com

The docking station is intended for use with the Rugged TROLL 100, 200 and Rugged BaroTROLL 
Instruments that are not deployed with a communication cable. Once connected, you can program the 
instrument, view readings, and download the data.

The docking station is intended for use with the Rugged TROLL 100, 200 and Rugged BaroTROLL 
Instruments that are deployed with a communication cable. Once connected, you can use the VuSitu mobile 
app to program the instrument, view readings, and download the data.

Unscrew and remove 
the hanger from the 
instrument.

Unscrew and remove 
the hanger from the 
instrument.

Place the instrument into 
the docking station.

Connect the other end of 
the cable to the Wireless 
Rugged TROLL Com.

The hanger is the only removable part of the instrument. Do not attempt to take the 
instrument apart. There are no user-serviceable parts in the instrument.

Invert the instrument. 
Align the notch on the 
instrument with the 
tab on the rim of the 
docking station. This 
will ensure that the pins 
are aligned to enable 
communication.

Invert the instrument. 
Align the notch on the 
instrument with the 
tab on the rim Rugged 
TROLL Cable. This will 
ensure that the pins 
are aligned to enable 
communication.

Connect the docking 
station to a computer.

Press the button on the 
Wireless Rugged TROLL 
Com and open the VuSitu 
Mobile app to pair.
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Connect to the Rugged TROLL Com

The Rugged TROLL Com is used as a communication interface between a Rugged TROLL 200 or a Rugged 
BaroTROLL instrument, the Rugged TROLL 200 cable and a computer.

An internal 9 volt battery powers the Rugged TROLL Com, but it does not provide power to the instrument. 
The Rugged TROLL Com connects to the uphole end of the Rugged TROLL 200 cable. Once connected, you 
can program the instrument, view real-time readings, and download the data.

Do not submerge the Rugged TROLL Com Device.

Rugged TROLL Com battery installation

Connections

Attach the Rugged TROLL 
Com to the Rugged 
TROLL 200 cable via 
snap-on connection to 
the uphole end of the 
cable.

Open the battery 
compartment door.

Attach the battery leads 
to the battery terminals.

Push the battery into the 
compartment and close 
the door.

Connect the 
communication cable to 
the PC.

Release the connection 
to the uphole cable end 
by pushing in the white 
tab on the TROLL Com.

The Rugged TROLL Com requires a minimum of 8 VDC. If you lose connection to the 
instrument, particularly when using a long cable, replace the 9 V battery on the TROLL Com.
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Deploying instruments

You can deploy a Rugged TROLL Instrument with or without a Rugged BaroTROLL Instrument. Use the 
Rugged BaroTROLL Instrument when you want to compensate water level measurements for atmospheric 
pressure.

Use the following steps for each instrument.

Connect the instrument to a computer and Win-Situ 
5 software.

Attach the instrument to a Wireless Rugged TROLL 
Com and connect to the VuSitu mobile app.

The BaroTROLL measurements can be taken far apart as long as they cover the general time 
period as the Rugged TROLL log.

If the Rugged TROLL log uses the reference “Set first logged reading to,” the Rugged BaroTROLL 
log should start before the Rugged TROLL log to ensure that barometric pressure is measured 
when the first level reading is captured.

If you choose to connect with Win-Situ, be sure to 
sync the clock.

Program a log. See the Win-Situ 5 or VuSitu section of 
this document for more details.

or

1

2

1

3
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Figure 11.1 Rugged BaroTROLL and Rugged TROLL deployment

1 Pressure due to atmosphere + water column (measured by Rugged TROLL)

2 Pressure due to atmosphere (measured by Rugged BaroTROLL)

3
Pressure due to water column (calculated by subtracting Rugged BaroTROLL data from Rugged 
TROLL data)

4 Rugged BaroTROLL Instrument

5 Rugged TROLL Instrument

Do not submerge the Rugged BaroTROLL Instrument.
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Rugged TROLL 200 Cable Suspension
When a Rugged TROLL 200 Instrument or a Rugged BaroTROLL Instrument needs to be installed with a 
secure fastener, such as a carabiner, In-Situ Inc. recommends using the Rugged TROLL 200 Cable Suspension 
Kit (Part Number 0080880).

When installed correctly the connector can support a combined cable and instrument weight of up to 45.4 
kg (100 lbs).

Create a loop on the 
uphole end of the cable 
and loosely bind it with 
one zip tie.

Place the metal loop 
inside the cable loop. 
Push the zip tie up to 
form a tight band around 
the metal loop. 

Tighten the zip tie. Place the second zip tie 
directly below the first 
and tighten.

Place the third zip tie 
about 2.5 cm (1 in.) 
below the first two ties. 
Place the fourth zip tie 
snugly against the third.

Clip the excess tie 
material from the unit.

Deploy from a well dock 
or other secure location.
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Wiring connections for stripped-and-tinned cable

SDI-12 connections

The Rugged TROLL 200 Cable can be ordered with stripped-and-tinned wires that can be connected to an 
SDI-12 or RS485 data recorder or controller.

Terminate remaining wires at the data recorder.

• Blue = serial data

• Red = 12 V power supply

• Black = ground

To learn more about using SDI-12 to communicate with a Rugged TROLL, see the SDI-12 
Commands Tech Note on In-Situ’s website.
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RS485 connections

• Red = 12 V power supply

• Black = ground

• Green = RS485 (-)

• Blue = RS485 (+)

Terminate remaining wires at the data recorder.

To learn more about using RS485 to communicate with a Rugged TROLL, see the In-Situ 
Modbus Communication Protocol on In-Situ’s website.
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Win-Situ overview

Data tab
When you open Win-Situ 5 Software, the Data tab appears. The left side of the screen contains a file tree 
where you can view previously downloaded site data as well as data you have exported to Microsoft Office 
Excel. The links on the right side of the screen show where downloaded data are stored on your computer. 
The disconnected plug icon in the lower-right corner of the screen indicates that the software is not yet 
communicating with an instrument.

Screen element Definition

The disconnected plug indicates the instrument is not communicating with the 
software. Click to establish communication with a connected instrument.

The connected plug indicates the instrument is communicating with the 
software. Click to disconnect the software from the instrument.

The Home tab displays real-time readings from the instrument. When 
connection to the instrument is first established, the software displays one 
reading of all available parameters in light gray. You must click the Play button 
at the bottom of the screen to view real-time readings.

The Logging tab displays a list of logs stored in the connected instrument. When 
you click the Logging tab, it can take a moment for the software to retrieve 
information from the instrument. (Not applicable for the RDO PRO-X and the 
Aqua TROLL 400.)

The Sensors tab lists the sensors in the connected instrument, along with their 
serial numbers and the dates of factory calibration and user calibration. Use 
the buttons in this tab to calibrate sensors that support user calibration and 
configure sensors that are supported by the instrument.

The Device Setup tab allows access to instrument information and settings such 
as instrument name, serial number, firmware version, communication settings, 
diagnostics, and factory reset options.
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Home tab
The Home tab displays real-time readings from a connected instrument. When you first establish 
communication, the software displays one reading of all available parameters.

Screen element Definition

The Sites button allows you to add, edit, or delete a site. Click the drop-down 
arrow next to the button to view the list of sites.

The Device Memory gauge turns yellow when the internal memory is used. 
Note: Non-logging instruments do not have internal memory, however, the 
gauge shows 100 percent green when power is applied.

The Device Battery gauge turns yellow as the battery is depleted. This 
example shows 80 percent of the battery remaining (green) and 20 percent 
used (yellow). Note: Non-logging instruments do not have internal batteries, 
however, the gauge shows 100 percent green when power is applied.

The Logging Status icon:
Green—The instrument is actively logging data.
Gray—The instrument has no logs pending or running. Non-logging 
instruments always show a gray status icon.
Yellow—The instrument has log data that was collected according to specific 
instructions in the “Pending” or
“Suspended” state.
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The Alarm icon provides additional instrument status information.
Green—No alarms or warnings 
Yellow—One or more warnings 
Red—One or more alarms
Move the cursor over the alarm icon to view a description. Click the Device 
Setup tab for detailed information on the alarm or warning.
Note: Disregard the Device Reset alarm for non-logging instruments such as the 
RDO PRO Probe or the Aqua TROLL 400.

System Time is displayed on the left. Device Time is displayed on the right. 
Clocks are updated once every two seconds. When the Device Time is displayed 
in red, it differs from the current System Time, and should be synchronized.

The Time Sync button is used to write the current PC time to the instrument. If 
you need to set the instrument clock to a time other than the system (PC) time, 
use the Set Clock button on the Device Setup tab.

Meter View shows the last known parameter values, displayed with current 
units and time stamp. Readings are sized to occupy the entire screen. This is the 
default display in the Home tab. If the type is black, the readings are updating in 
real time.

List View is a running list of the most recent records. New readings are 
continuously added to the top of the list and old readings scroll off the bottom.

Graph View shows a real-time trend graph of the selected parameters.

The Snapshot button records one set of readings.

The Record button logs data to a CSV file that can be opened in a spreadsheet 
program. This is not the same as recording data in a log on the instrument.

Logging tab
The Logging tab displays a list of logs in the instrument. When you click the Logging tab, it may take a 
moment for the software to retrieve information from the instrument.
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Log information

Log status

Columns across the Logging screen show information about the logs in the instrument.

• Symbol—This is a graphic representation of the information in the Status column.

• Site—The site that was specified when the log was configured.

• Log Name—The name that was entered when the log was configured.

• Type—The logging method that was selected when the log was configured.

• Start Time—For a Pending log, the scheduled start time is shown. For a Ready log that has not yet 
started, this column displays “Manual.” For a Running or Stopped log, the actual start time is shown.

• Scheduled Stop Time—For a log with a scheduled stop, the scheduled stop time is shown. For a log 
without a scheduled stop time, this column is blank.

• Stop Time—For a Pending or Ready log, this column is blank. For a Running log, the time of the last 
data point is shown. For a Stopped log, the actual stop time is shown.

• Status—Each log has a specific status. See Log Status for details.

• Used Size—Kilobytes of instrument memory allocated for this log. For a Pending or Ready log, the 
current size of the log configuration is shown. For a Completed log, the size of the entire log file is 
shown. For a Running log, the current size of the log up to the last data point is shown.

The status of each log in the instrument is displayed in the Logging tab by a symbol beside the log name, 
and in the Status column.

Ready—Manual Start log is ready to start.

Pending—Scheduled start log is ready to start at its programmed time, or when you click the 
Start button.

Running—The log is actively logging data.

Suspended—The log has been paused (stopped temporarily).

Stopped—The log has been stopped, either manually or on a schedule.

Deleted—The log has been marked for deletion and will be deleted from the instrument when 
memory is needed. The software manages this automatically.

Invalid—The log as programmed cannot be run.

Ready, Pending, Running, and Suspended logs are considered active. Only one log can be 
active in the instrument.
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Log control buttons

Log operations

You can control the status of a log by selecting the log and clicking the appropriate button in the Logging 
tab control panel:

The Start button starts a Ready or Pending log, or resumes a Suspended log.

The Pause button pauses a Running log allowing you the option to resume it.

The Restart button restarts the selected Running log from the beginning. This can be useful during 
aquifer testing using a logarithmic data collection schedule.

The Stop button permanently stops the selected Running log.

Use the buttons in the control panel to perform the following actions:

Create a new log.

The New button is disabled if a Ready, Pending, Running, or Suspended log is on the instrument. When the 
instrument contains its maximum number of logs, the New button is unavailable.

Edit (or review) the log configuration for a Ready, Pending, or Invalid log.

Delete the log. (Note that you must delete a log twice before it is permanently removed.)

Download the log to a PC.
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Calibrate

Configure

Use the Calibration button to calibrate sensors or to adjust a level reference that is currently stored on the 
instrument. The Calibrate button is not available when the instrument does not support calibration (e.g. 
BaroTROLL Instrument).

Use the Configure button to select parameter units and to configure parameters that support configuration. 
Examples include Level/Depth, Specific Conductivity, and Total Dissolved Solids. Parameters cannot be 
configured while the instrument is showing live data on the Home screen or while the instrument contains 
an active log.

1. With the instrument connected to the software, select the Sensors tab.

2. Select the parameter you intend to calibrate.

3. Click the Calibrate button

1. With the instrument connected to the software, select the Sensors tab.

2. Select the parameter you intend to configure.

3. Click the Configure button.

When you configure the Level parameter using the Sensors tab, the settings are stored in the 
instrument and are available for use in Modbus, SDI-12, or analog communication (if available). 
If desired, a different configuration can be selected when setting up a log.

Sensors tab
The Sensors tab lists the sensors in the instrument, along with their serial numbers and calibration dates. Use 
the buttons in this tab to calibrate and configure sensors.
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Device setup tab
In general, you should not use the Device Setup tab unless you are corresponding with the In-Situ technical 
support team. However, you can use this screen to set up communication protocols if you are connecting 
the instrument to a PLC or data logger.

Using Win-Situ 5 software
Connecting an instrument to the software

Steps for Windows 8�1 and Windows 10 systems�

Steps for Windows 8 systems�

Selecting the correct COM port

When you open Win-Situ 5 Software, you are asked if you want to connect to your device. Click Yes. 
Synchronize the instrument clock to the PC clock.

The software displays an error message if a connection cannot be established.

If you are using a USB TROLL Com, select the correct COM port by following the steps below. If you are using 
a serial TROLL Com, the Win-Situ Software should default to the correct COM port, which is usually COM 1.

1. Right-click the Start button.

2. Click Device Manager.

3. Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port listing. The number listed 
next to this entry is your COM port address.

1. Right-click the Start screen.

2. Select All Apps.

3. Click Control Panel.

4. Open the Device Manager.

5. Click the arrow next to Ports (Com and LPT), and locate the USB Serial Port listing. The number listed 
next to this entry is your COM port address.
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Steps for Windows 7 systems�

Steps for Windows XP systems�

1. Click the Start button, and open the Control Panel.

2. Click Hardware and Sound, and open the Device Manager.

3. Click the arrow next to Ports (COM and LPT), and locate the USB Serial Port listing. The number listed 
next to this entry is your COM port address.

1. Click the Start button, and open the Control Panel.

2. Double-click the System icon. Click the Hardware tab, and open the Device Manager.

3. Click the plus sign next to Ports (COM and LPT), and locate the USB Serial Port listing. The number 
listed next to this entry is your COM port address.

The following steps apply for all Windows operating systems.

1. Once you have determined the correct COM port address in your operating system, reopen Win-Situ 
5 Software.

2. Close any open windows in Win-Situ Software.

3. Click Preferences.

4. Click Comm Settings, and then click the Port Number menu.

5. Scroll down to find the correct COM port address. Click the check mark to accept the changes.

6. Click the yellow Connect button in the lower right corner to establish a connection to the instrument.

Setting the instrument time

Adding a new site

The PC time appears on the left, the instrument time on the right. Both clocks are updated at 0.5 Hz (once 
every two seconds). The device time is displayed in red if it differs by more than a few seconds from the 
current PC time. Data logging schedules depend on a correct instrument time.

To synchronize the instrument time to the current PC time, click the Clock Sync button Win-Situ writes the 
current PC time to the instrument.

To add a new site to the site database in your working directory do one of the following:
On the Data tab, click the Site Data folder, select File> New > Site.
or
On the Home tab, click the Site button to display the site list, then click New . Enter a name for the site. This 
is the only required field.
Click Save to save the new site. The new site will appear in the Site Data folder, and Win-Situ will add it to 
the site database in the working directory on your computer. It is now available to select for any instrument 
log.

The instrument time and the current PC time are shown at the top of the screen when an instrument is 
connected to the software.
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Log setup

Logging method descriptions

The Log Setup Wizard presents sequential screens to help you supply all the information necessary to set up 
a data log in the instrument.

To access the Log Setup Wizard the instrument must be connected to the software.

The following is a list of log types and their descriptions. The log types that are available on an instrument 
vary depending upon the capabilities of the instrument.

1. Click the Logging tab.

2. Click the New button.

The New button may be disabled or may show a warning if an active log already exists on 
the instrument, or if the instrument is polling live data (see the Home screen), or if the device 
already contains its maximum number of logs.

3. Select the Site where the set of data will be logged and supply a name for the log.

4. Click the right arrow to continue after each step.

5. Select the parameters you intend to measure, choose the measurement units, and specify the order 
in which the selected parameters will be logged.

6. Select the logging method you intend to use. See page 35.

7. Select the log interval. A log interval is how often a measurement will be taken and stored.

8. Select the start condition, stop condition, and specify how to handle full device memory.

9. If you selected Level or Depth as a parameter to measure, specify how you intend to log this 
parameter. 

10. The final screen summarizes the log setup. Click the check mark to write this information to the 
instrument.

Linear

Event

Linear log type measures and records at a user-defined fixed interval of one minute or more. 
This method is used for long-term studies, landfill monitoring, stream gauging, tidal studies, and 
background monitoring prior to aquifer testing. Intervals are measured in days, hours, or minutes.

Linear Event log type combines basic fixed-interval logging of specified parameters with the ability to 
log data at a faster interval when a single-parameter event condition is present.
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About the level reference

Starting a log

A Level Reference, also called an offset, is a user-specified starting point for logged Level readings. It is 
entered in the Logging Setup Wizard when a log is configured, or it can be stored in the device without 
configuring a log using the Configure button in the Sensors tab.

Depth mode does not require that you enter a Level Reference.

The Level Reference can be any value you choose. Here are some examples:

• Elevation—If you calculate the water level above mean sea level (MSL) and enter this as the Level 
Reference, then elevations above MSL will be logged.

• Depth to Water—If you measure the depth to the water surface (DTW) from the top of the well 
casing and enter this as the Level Reference, then DTW (also called drawdown) values will be logged.

• Gauge Height or Stage—Logged readings track water level as related to markings on a nearby staff 
gauge.

• Zero—A Level Reference of 0 effectively sets the probe to zero at the start of the log. Changes, both 
positive and negative, from the starting water level, will be logged.

Once you have determined the value of your Level Reference, the software gives you three options for 
entering it. These control when the level reference is applied.

• New Reference—This option is designed to be used with an active software connection when the 
device is installed in the water.

A new level reference must be entered while the device’s pressure sensor is submerged in its 
final position in the water. This is because the current probe reading is set equal to the Level 
Reference to create the offset that takes effect at the start of the data log. The log header will 
show the probe reading at the time you entered the Level Reference.

During log setup, the software presents two additional options for entering the Level Reference:

• Set first logged reading—Use this option when the instrument will be deployed on wire rather than 
cable because you will not be able to communicate with the instrument when it is submerged.

• Remind me to set reference later—Use this option to defer the entry of the Level Reference during 
log setup and set a reminder to enter it when the device is submerged in its final position.

Every log is programmed for either a manual or a scheduled start. A log with a manual start time is displayed 
in the Logging screen with Ready in the Status column. A log with a scheduled start time is displayed with 
Pending in the Status column.

Starting a pending log

A pending log automatically starts at the scheduled time without any user intervention.

A scheduled log with Pending status can be manually started at any time before its scheduled 
start.
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Starting a manual log

Suspending (pausing) a Log

Resuming a suspended log

Stopping a log

With the instrument connected to the software, select the Logging tab. Select the Ready log you want to 
start.

A running log may be temporarily paused. For example, you might want to reposition an instrument, 
calibrate a sensor, or clean a sensor and later resume the log. A log can be suspended and resumed three 
times.

A log can be manually stopped at any time, even if a stop time has been previously scheduled. If you did not 
specify a stop condition when you defined the log, the log will run until the instrument is out of memory or 
battery power, or until you manually stop it.

Click the Start Log button. The log starts and the symbol changes. The Status column displays Running.

1. With the instrument connected to the software, select the Logging tab

2. Select the log you intend to suspend.

3. Click the Suspend button. Suspended appears in the Status column.

1. To resume logging after a log has been suspended, select the Logging tab.

2. Select the Suspended log.

3. Click the Start Log button. Logging resumes. Running appears in the Status column. The data file will 
show the time when the log was suspended and the time when it restarted.

A log that has been stopped cannot be resumed. If you intend to resume a log later, you should 
suspend a log rather than stop it.

1. To manually stop a log, the instrument must be connected to the software.

2. Select the Logging tab.

3. Select the running log you intend to stop.

4. Click the Stop Log button.

Downloading data to a PC
This procedure copies the data log from the instrument to a PC. It does not remove the data log from 
the instrument. After a log is downloaded, it can be exported to a CSV file format that can be used by 
spreadsheet programs. The time shown in the log name is the time the log was downloaded.

1. With an instrument connected, select the Logging tab

2. Select the log you intend to download.

3. Choose a Running, Suspended, Stopped, or Deleted log.

4. Click the Download button.

5. In the next screen, select one of the three download options.

• All data

• New data (data logged since the last download)

• Time interval to download
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New data is downloaded by default to a new log file. To append new data to the last download 
of this log, be sure the option “Append logs on download” is selected in the General Settings 
dialog (Preferences > General Settings).

6. The log is copied to the connected PC into your Win-Situ working directory folder. View or change 
the working directory using File > Settings.

7. At the end of the download, Win-Situ gives you the option of viewing the data.

8. Select Yes and the log is displayed in the Data screen.

9. Select No and the Logging screen appears. You can view the data at any time by selecting it in the 
Data tab.

Viewing logged data
To view the data stored in the instrument, you must first download the data. A connection to an instrument 
is not needed after the data log has been downloaded.
Select the Data tab.
3. On the left side of the screen, select the log you want to view. To expand a folder shown in the navigation 
tree, double-click the folder. The content of the data log is displayed on the right side of the screen in text or 
graph format.

To switch between view formats, click the Text or the Graph button in the control panel. To 
customize the text or graph view, select Preferences > Graph Settings or Preferences > Data 
View Settings. These options apply to all downloaded data until you change the options.
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Importing VuSitu data to Win-Situ
You can import data files from VuSitu into Win-Situ 5 from the File menu.

Click File > Import VuSitu CSV in the menu bar at the 
top of the screen.

Select the file you wish to import and click Open.

Select OK at the prompt. Click on the file name to view it.
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Using BaroMerge software

BaroMerge Software is used to post-correct absolute (non-vented) level sensor data to eliminate barometric 
pressure effects from the measurements. BaroMerge Software can be accessed through the Win-Situ 5 
Software Tools menu. BaroMerge provides three options to correct data.

• Fixed Correction—A single offset value is applied to all selected log data. Use this option if you 
know the barometric pressure of the site during the log, and know that it did not change.

• Manual Entry—Specify two or more correction values to apply to the log data. Use this option if 
you wish to manually enter a data set of barometric pressure values.

• BaroTROLL log file—Absolute level sensor data points are individually corrected to reflect 
barometric pressure changes that were logged by a BaroTROLL instrument during the approximate 
time period.
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Baro Merge input—fixed correction
If you select the Apply a fixed correction option, a single correction is applied to all values in the log.
To use this correction method you need barometric pressure values from a reliable source. Choose a single 
value that represents the actual ambient barometric pressure during the time period the log was recorded. 
You also need to know the file names of the logs you want to correct.

1. From the Tools menu, select Win-Situ Baro Merge.

2. Select the Apply a fixed correction option.

3. Enter the barometric correction value and select units from the drop-down menu.

4. Click the right arrow button.

5. Select the log files to which the correction will be applied and click the check mark button.

6. Compensated data files can be viewed or exported from the Data tab.
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Baro Merge input—manual entry
When you select the Fixed Correction and Manual Entry options, it is important to know the barometric 
pressure for the general time period covered by the log or logs you want to correct.

1. From the Tools menu, select Win-Situ BaroMerge�

2. Select the Enter one or more values manually option.

3. The compensation table appears that allows you to build a table of barometric data that corresponds to 
the time the log was recorded. The compensation table has three preference options:

• The first option, Save calculated barometric adjustments in the new data file(s) is the default 
option. It adds additional columns depending on which parameters were selected for the absolute/
non-vented log in the corrected BaroMerge file that uses the compensation table values. This is 
intended to show how the adjustments were done in the BaroMerge file. If you do not want to show 
these adjustments, clear this option.

• When the second option, Show time in UTC is selected, the compensation table time stamp 
displays in Coordinated Universal Time (UTC) time, formally known as Greenwich Mean Time (GMT).
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• If the third option, Ignore daylight saving time (DST) is selected, the compensation table time 
stamp format without the daylight savings time adjustment will be shown.

4. Build a table that contains at least two barometric pressure values.

5. Click the right arrow and select the absolute (non-vented) log file or files you intend to correct.

6. Click the check mark and the barometric compensation is applied.

7. Compensated data files can be viewed or exported from the Data tab.

BaroMerge output

Disconnecting an instrument from the software

Your original log file is not changed. A new, corrected log file with the same name and path is created. The 
original “.wsl” extension is replaced by “-Baro Merge.wsl”.

Click the plug icon in the lower-right corner of the screen to disconnect the instrument from the software. 
Disconnect the instrument from the communication device. Attach a desiccant pack if you are using a 
vented cable.
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Connecting the Rugged TROLL to a PLC or Data Logger
The Rugged TROLL 200 and Rugged BaroTROLL may be connected to a controller or logger for 
communication via:

• SDI-12

• RS485 Modbus

• RS232 to Modbus (with a customer-supplied converter)

• Top-of-Well Cable Connector and RS485 Modbus wiring

• Stripped-and-Tinned termination and RS485 Modbus wiring

• Stripped-and-Tinned termination and SDI-12 wiring

A Rugged TROLL Direct Read cable connects a Rugged TROLL 200 or Rugged BaroTROLL Instrument directly 
to a controller or logger for communications. The direct read cable is non-vented and is available in the 
following options:

Direct Read Cable - Stripped and Tinned with RS485 Modbus Wiring

Direct Read Cable - Stripped and Tinned with SDI-12 Wiring

Refer to the diagrams on the following page for PLC wiring diagrams. Unused leads should not 
be touching.

Wiring Overview

Signal Color

Ground/Return Black

External Power Red

RS485 (-) Green

RS485 (+) Blue

Power

Ground

RS485 (+)

RS485 (-)

Signal Color

Ground/Return Black

External Power Red

SDI-12 Blue

Power

Ground

SDI-12
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Redundant logging
The Rugged TROLL 200 and Rugged Baro TROLL can continue recording data to a log while connected to a 
PLC. If the PLC or recorder loses data or stops recording, the instrument will continue to collect data using its 
own internal batteries and clock. See the VuSitu section of this manual for more information on setting up a 
data log on the instrument.

Power connections

Communication modes

The red wire provides power for Modbus and SDI-12 communication modes.

The device automatically switches between Modbus and SDI-12 modes depending on which cable is in use.
Modbus and SDI-12 communications are strictly dependent on the cable type that was purchased.

SDI-12 wiring diagram

Modbus (RS485) wiring diagram
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Modbus PLC Interface

The Modbus PLC Interface is a simplified method of communicating with the Rugged TROLL using the 
Modbus protocol. For information about the specific Modbus registers and Unit IDs for your Rugged TROLL, 
see Appendices A and B. The Rugged TROLL conforms to the Modbus standard. For more information about 
Modbus communication, see www.modbus.org.

Overview

Configuring SDI-12 Settings

You can configure the list of SDI-12 parameters in VuSitu under Instrument Settings�

The Rugged TROLL conforms to the general SDI-12 Standard Version 1.3. For more information about SDI-
12 commands, see the SDI-12 Standard Version 1.3 document from the SDI-12 Support Group Technical 
Committee.

About SDI-12

Configure SDI-12 Settings in VuSitu

Drag and drop 
parameters to change 
the order.

Connect to VuSitu and 
select Instrument 

Settings�

Choose SDI-12 Settings� Use the checkboxes to 
select parameters to 
display.

Tap the gear icon to 
adjust the units for each 
parameter.
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Holding Register

Number

Holding Register 

Address

Size

(Registers)

Data 

Type

Description

9001 9000 1 uint16 Device Id: 
16 = Rugged TROLL 200
17 = Rugged Baro TROLL

9002 9001 2 uint32 Serial Number

9007 9006 1 uint16 Firmware version (100 = 1.00) 

1. Connect power, and wire the instrument.
2. The setup below is using the instrument's factory default settings. Use VuSitu to reset the instrument to 
factory defaults if they have been changed. Take note of any changes in default units setup.

Setting Up Instrument

2. Set the device address match the instrument address. The default device address is 1.
3. Set the PLC to wake-up the device by sending a carriage return (0x0D) or any Modbus command.
 a. Allow one second before sending a second command. The instrument needs this time to wake up.  
 b. After the wake-up command, the next reading must be taken before the end of session timeout.  
 If the reading interval exceeds the end of session timeout, send a new wake-up  command before  
 requesting a new reading. The default end of session timeout is 5 seconds, and may be longer if the  
 instrument has been connected to VuSitu.
4.  Select the register to read on the PLC using the information in the following sections.
  a. Some PLC devices use the register number directly in programming statements, others use register
 addresses, which are one less than the register number. Refer to PLC manufacturer instructions to  
 determine which programming style to use. 
 b.  Each register is a holding register. Some PLCs require you to add 40000 to the register number or
 address. For example: 5451 would be 45451.
5.  Set the type of register to: 32-bit float
  a. If asked by the PLC this is 2 registers
6.  Set the byte order to: Big Endian (MSB)
  a. This should be the default and may not be configurable on all PLCs

1. Set up the serial communication to match the instrument communication settings. Communication 
settings can be changed with the VuSitu mobile app. The default communication settings are:

Programming the PLC

Mode Start Bit Baud Rate Data Bits Parity Stop Bit

RTU 1 19200 8 Even 1

Reading Device Information
Use the following registers to read general information about the instrument.
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Reading Parameters
Each parameter contains a block of 7 registers as shown in the table below. To read measurements for a 
specific parameter, look up the starting register for that parameter from the list of Parameter Numbers 
and Locations in Appendix A. Once you have the starting register, add the number of offset registers for 
additional information about the reading.

For example, you can apply this information to collect a reading for Pressure.

From the list in Appendix A, you can find that the starting register for Pressure is 0038. A reading from 
register number 0038 (register address 0037) will return the measured value of Pressure 

Some PLC devices use the register number directly in programming statements, others use register  
addresses. Refer to PLC manufacturer instructions to determine which programming style to use.

You can use the register offsets listed in the table above to collect additional information about the reading. 
Adding the register offset of 2 to the starting register, you can find that register number 0040 (register 
address 0039) will return the Data Quality ID for the most recent Pressure measurement. Likewise, register 
number 0041 (register address 0040) will return the Units ID, which can be interpreted from Appendix B. 
Register number 0042 (register address 0041) will return the Parameter ID, which can be interpreted from 
Appendix A. Register number 0043 (register address 0042) will return the sentinel value.

The Units ID and Sentinel Value are writable registers. Measurements can be changed to other units using 
the Units ID as shown in Appendix B. For example, if register number 0041 (Pressure Units ID) returns 17, 
Pressure is configured to report in psi. Looking at Appendix B, you can find that kPa is also a valid unit which 
can be set by writing Units ID 19 to register number 0041.

Register 

Offset

Size

(Registers)

Mode

 (R/W)

Data Type Description

0 2 R float The measured value from sensor

2 1 R uint16 Data Quality ID: 
0 = No errors or warnings
3 = Error reading parameter
For additional errors or information, contact 
technical support.

3 1 R/W uint16 Units ID for this parameter. See: Appendix B.

4 1 R uint16 Parameter ID for this parameter. See: Appendix A.

5 2 R/W float Off line sentinel value: The value that’s returned 
on error or if the parameter isn’t available. The 
default sentinel is 0.0
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Maintenance, Cleaning, and Storage

O-ring inspection and replacement

Cleaning the instrument

Storage

Examine O-rings for wear, dryness, discoloration, stretching, cracks, nicks, and brittleness. Replace O-rings 
if one or more of these conditions are present. Replacing O-rings on an annual basis, regardless of their 
condition, is the best way to protect against moisture damage.

Perform the following steps to replace an O-ring.

Clean the instrument body with water and a soft brush or plastic scouring pad, or soak overnight in a mild 
acidic solution, such as household vinegar. 

If the ports near the pressure sensor are clogged with silt or mud, try the following procedures.

Do not attempt to remove material from the instrument by tapping the instrument against a surface. You 
void the instrument’s warranty by inserting anything into the sensor opening. If contamination cannot be 
removed using the recommendations above, please contact In-Situ for cleaning.

Store the instrument in a clean, dry place. Store the instrument where it will not roll off a bench onto a hard 
surface or sustain other mechanical shock. Protect the instrument from temperature extremes.
Store the Rugged TROLL within the temperature range -40° C to +80° C (-40° F to +176° F).

1. Remove and discard the damaged O-ring.

2. Use a clean, dry, soft cloth to clean the O-ring groove to remove dirt or residue.

3. Lubricate the new O-ring using high-vacuum grease.

• Wash your hands thoroughly.

• Apply a small amount of grease to the pad of your index finger, and rub your index finger and 
thumb together to spread the grease evenly.

• Inspect the new O-ring and remove any debris stuck to it.

4. Rub your fingers around the O-ring until there is a thin layer of grease on the entire O-ring.

5. Install the O-ring in the groove and remove any excess lubricant with a clean cloth.

Do not allow water or lubricant to enter the connector.

• Agitate the instrument vigorously in a bucket of clean water.

• Apply a gentle rinse of water from a wash bottle.

NEVER submerge the connector portion of the instrument when it is not connected to a cable.
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Service

Obtaining repair service

Guidelines for cleaning returned equipment

Outside the U.S.

If you suspect your system is malfunctioning and repair is needed, you can help assure efficient servicing by 
following these guidelines:

Contact your international In-Situ distributor for repair and service information.

Please help us protect the health and safety of our employees by cleaning and decontaminating equipment 
that has been subjected to any potential biological or health hazards, and labeling such equipment. 
Unfortunately, we cannot service your equipment without such notification. Please complete and sign the 
form in your Operator’s Manual (or a similar statement certifying that the equipment has been cleaned and 
decontaminated) and send it with each returned instrument.

• We recommend a cleaning solution, such as Alconox®, which is a glassware cleaning product 
available from In-Situ (part number 0029810) or laboratory supply houses.

• Clean all cabling. Remove all foreign matter.

• Clean cable connector(s) with a clean, dry cloth. Do not submerge cable connectors.

• Clean the probe body—including the nose cone, cable head, and protective caps. Remove all foreign 
matter.

1. Call or email In-Situ Technical Support. Have the product model and serial number available.

2. Be prepared to describe the problem, including how the product was used and the conditions noted at 
the time of the malfunction.

3. If Technical Support determines that service is needed, they will ask your company to fill out the RMA 
form and pre-approve a specified monetary amount for repair charges. When the form and pre-approval is 
received, Technical Support will assign an RMA (Return Material Authorization) number.

4. Clean the product as described in the manual.

5. If the product contains a removable battery, remove and retain it unless you are returning the system for 
a refund or Technical Support states otherwise.

6. Carefully pack your product in its original shipping box, if possible.

7. Mark the RMA number clearly on the outside of the box.

8. Send the package, shipping prepaid, to:

In-Situ
ATTN: Repairs
221 East Lincoln Avenue
Fort Collins, CO 80524-2533
The warranty does not cover damage during transit. In-Situ recommends insurance for all shipments. 
Warranty repairs will be shipped back prepaid.
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Decontamination and cleaning form

Decontamination & cleaning statement

Company Name Phone

Address

City State

Instrument Type Serial Number

Contaminant(s) if known)

Decontamination procedure(s) used

Cleaning verified by Title

Date



If an instrument is returned to our Service Center for repair or recalibration without a 
statement that it has been cleaned and decontaminated, or if it is the opinion of our Service 
Representatives that the equipment presents a potential health or biological hazard, we 
reserve the right to withhold service until proper certification is obtained.
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Declarations of Conformity and Similarity

Rugged TROLL 100

 

  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

CE Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Rugged TROLL 200 : 
Product name: Rugged TROLL 100 
Model: Rugged TROLL 100 
Part Number: 0091870 
Product Description: The Rugged TROLL 100 is a water depth sensor that is designed for short- or long-
term deployments in wells, lakes, rivers or oceans. 
Model Variants: The Rugged TROLL 100 models vary by maximum depth.  The models available are: 0-30 ft 
(0-9m), 0-100 ft (0-30m) and 0-250 ft (0-76m). 

These are in compliance with the following Directives: 

 

 2014/30/EU EMC Directive 
 

 Restriction of the use of certain hazardous substances in electrical and electronic 
equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU) 
2015/863 

and meet or exceed the following international requirements and compliance standards: 

EMC Standard: 
  EN 61326-1:2021 

RoHS Standard: 
EN 63000:2018 
 

The CE mark is affixed accordingly. 

 
David A. Bossie                

Regulatory Compliance Manager              

In-Situ, Inc. 

July 13, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

UKCA Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

We declare that the performance of each of the following products is equivalent to the Rugged TROLL 200: 
Product name: Rugged TROLL 100 
Model: Rugged TROLL 100 
Part Number: 0091870 
Product Description: The Rugged TROLL 100 is a water depth sensor that is designed for short- or long-
term deployments in wells, lakes, rivers or oceans. 
Model Variants: The Rugged TROLL 100 models vary by maximum depth.  The models available are: 0-30 ft 
(0-9m), 0-100 ft (0-30m) and 0-250 ft (0-76m). 

These products are in compliance with the following Regulations: 

 
 EMC Regulation 2016 

 Restriction of the use of certain hazardous substances in electrical and electronic 
equipment (RoHS) Regulation (S.I. 2012:3032) 

and meet or exceed the following British requirements and compliance standards: 
 

 EMC Standard: BS 61326:2021 
 

 RoHS: BS 63000:2018 
 
 

The UKCA mark is affixed accordingly. 

 

David A. Bossie                   
Regulatory Compliance Manager              
In-Situ, Inc. 
July 13, 2022 
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Rugged TROLL 200

 

 

  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

CE Declaration of Conformity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that the following product: 
Product name: Rugged TROLL 200 

Model: Rugged TROLL 200 
Part Number(s): 0091930, 0091940, 0091950 
Product Description: The Rugged TROLL 200 is a water depth sensor that is designed for short- or long-
term deployments in wells, lakes, rivers or oceans. 
Model Variants: The Rugged TROLL models vary by maximum depth.  The models available are: 0-30 ft (0-
9m), 0-100 ft (0-30m) and 0-250 ft (0-76m). 

is in compliance with the following Directive: 

 
 2014/30/EU EMC Directive 

 Restriction of the use of certain hazardous substances in electrical and electronic 
equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU) 
2015/863 

and meets or exceeds the following international requirements and compliance standards: 

EMC Standards: 
  EN 61326-1:2021 

RoHS Standard: 
EN 63000:2018 
 

The CE mark is affixed accordingly. 

 

David A. Bossie                    
Regulatory Compliance Manager              
In-Situ, Inc. 
July 13, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

UKCA Declaration of Conformity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

We declare that the performance of the following product: 

Product name: Rugged TROLL 200 

Model: Rugged TROLL 200 
Part Number(s): 0091930, 0091940, 0091950 
Product Description: The Rugged TROLL 200 is a water depth sensor that is designed for short- or long-
term deployments in wells, lakes, rivers or oceans. 
Model Variants: The Rugged TROLL models vary by maximum depth.  The models available are: 0-30 ft (0-
9m), 0-100 ft (0-30m) and 0-250 ft (0-76m). 

 
is in compliance with the following Regulations: 

 EMC Regulation 2016 

 Restriction of the use of certain hazardous substances in electrical and electronic 
equipment (RoHS) Regulation (S.I. 2012:3032) 

and meets or exceeds the following British requirements and compliance standards: 
 

 EMC: BS 61326-1:2021 
 

 RoHS: BS 63000:2018 
 
 

The UKCA mark is affixed accordingly. 

 

David A. Bossie                   
Regulatory Compliance Manager              
In-Situ, Inc. 
July 12, 2022 
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Rugged BaroTROLL

 

 

  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

CE Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

Declares that performance of each of the following products is equivalent to the Rugged TROLL 200 : 
Product name: Rugged Baro TROLL 
Model: Rugged Baro TROLL 
Product Description: The Rugged Baro TROLL is used to compensate for barometric pressure when using a 
water depth sensor that is designed for short- or long-term deployments in wells, lakes, rivers or oceans. 
Model Variants: None 

These are in compliance with the following Directives: 

 

 2014/30/EU EMC Directive 
 

 Restriction of the use of certain hazardous substances in electrical and electronic 
equipment (RoHS) Directive, 2011/65/EU and Commission Delegated Directive, (EU) 
2015/863 

and meet or exceed the following international requirements and compliance standards: 

EMC Standard: 
  EN 61326-1:2021 

RoHS Standard: 
EN 63000:2018 
 

The CE mark is affixed accordingly. 

 
David A. Bossie                

Regulatory Compliance Manager              

In-Situ, Inc. 

November 15, 2022 
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  Copyright © 2015 In-Situ Inc. This document is confidential and is the property of In-Situ Inc. Do not distribute without approval. 

UKCA Declaration of Similarity 

Manufacturer: In-Situ, Inc. 
 221 East Lincoln Avenue, Fort Collins, CO 80524, USA 

We declare that the performance of each of the following products is equivalent to the Rugged TROLL 200: 
Product name: Rugged Baro TROLL 
Model: Rugged Baro TROLL 
Product Description: The Rugged Baro TROLL is a barometric pressure sensor used with a water depth 
sensor that is designed for short- or long-term deployments in wells, lakes, rivers or oceans. 
Model Variants: None 

These products are in compliance with the following Regulations: 

 
 EMC Regulation 2016 

 Restriction of the use of certain hazardous substances in electrical and electronic 
equipment (RoHS) Regulation (S.I. 2012:3032) 

and meet or exceed the following British requirements and compliance standards: 
 

 EMC Standard: BS 61326:2021 
 

 RoHS: BS 63000:2018 
 
 

The UKCA mark is affixed accordingly. 

 

David A. Bossie                   
Regulatory Compliance Manager              
In-Situ, Inc. 
November 15, 2022 
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Appendix 

Appendix A: Parameter Numbers and Locations - Rugged TROLL

Parameter Numbers and Locations - Rugged BaroTROLL

ID Parameter Name
Holding Register 

Number

Holding Register 

Address
Default Units

1 Temperature 0046 0045 1 = °C

2 Pressure 0038 0037 17 = PSI

3 Depth 0054 0053 38 = feet

4
Level, Depth to 
Water
(Enable with VuSitu)

0054 0053 38 = feet

5
Level, Surface 
Elevation
(Enable with VuSitu)

0054 0053 38 = feet

ID Parameter Name
Holding Register 

Number

Holding Register 

Address
Default Units

1 Temperature 0046 0045 1 = °C

16 Barometric Pressure 0038 0037 17 = PSI
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Appendix B: Unit IDs

ID Abbreviation Units

1 C Celsius

2 F Fahrenheit

Pressure, Barometric Pressure (17-32)

17 PSI Pounds per square inch

19 kPa Kilopascals

20 Bar Bars

21 mBar Millibars

22 mmHg Millimeters of Mercury (0 to C)

23 inHg Inches of Mercury (4 to C)

24 cmH
2
O Centimeters of water (4 to C)

25 inH
2
O Inches of water (4 to C)

Distance/Length (33-48)

33 mm Millimeters

34 cm Centimeters

35 m Meters

37 in Inches

38 ft Feet
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